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FROM THE CHAIRMAN
'm pleased to be able to report that we enjoyed
a fantastic event in October. when under the
umbrella of The Real Thing in itiative in
conjunction with the RPS, we staged Illusion and
Reality feawring Steve Caplin. The day was
memorable and excellent and we've a full report
on the next page. Our than.ks go to Jim Buckley
for his organisation and co-ordinating ski lls in
ensuring the day was an outstanding success. And
to Martin Addison and John Long for judging the
prints contributed by members. Without will ing
volunteers the whole event would not have run so
Digital Imaging Group
smooth
ly and in this respect we sincerely thank
Committee for 2009/10
Elizabeth Restall. Alex Dufty and David Gamm.
See opposite page for
plus Roger and Judith Parry from Smethwick
DIGRO contact details.
Photographic Society and their team of helpers. It
was good to have RPS President. Rosemary
Chairman: Clive Raynes FRPS
Wilman Hon FRPS with us on the day. Rosemary
01905 356405
was able to open the RPS International Print
chain11a11@digi1.rps.org
Ex hibition wh ich graced the walls of The Old
Vice-Chair
School
House.
Graham Whistler FRPS
01329 847944
This issue canies deta ils of our AGM. Everyone is
gra!ta111whist/e1@digi1.171s.org
welcome to attend. The day presents an
Secretary: Bob Pearson FRPS
opportunity for you to have your say about the
01404 841171
running of our group and to take part in the
secretary@digil.rps.org
election of commillee members. The day isn·t all
Treasurer: Elizabeth R1.,>stall LRPS
business by any means. We have the selection of
treasurer@digil.rps.org
prints for our members' exhibition and a great
Publicity and Website:
lecture
in prospect when digital imaging guru and
Joh n Long ARPS
worktlow
expert, Mike McNamce. will give an
01179 672231
joh11lo11g@digit.rps.org
illustrated presentation about The Impact of
Exhibitions: AJcx Dufty LRPS
Digital Imaging on the Creative Process.
01454 778485
If you haven't already booked your place for our
exhibi1io11@.digit.rps.org
Portraits. Fashion & Nudes Workshop on 24 and
OIGRO Co-ordinator
25 April 20 I0. then be aware tickets are going fast
Roger Norton LRPS
and we're already past the half-way stage for
digro@1psdig-t!tamesvalley.org.uk
numbers. lfll be an informative and inspirational
Associate Editor Dl GIT
event
- book your place as soon as possible.
Dr David Cooke ARPS
As
you
know from time to time I use my
01275 462248
da1•idfcookearps@gmail.co111
Chairman's Letter introduce a subject that I fee l
Maureen Albright ARPS
strongly about - and hopefully evoke a response
111aureenalhright@jdigil.1ps.01g
from our members. So here are some furU1er
Tony l:lcaly ARPS
thoughts ...
+61 (0) 2 9958 l 570
The Tyranny of the Cliche As alert and active
a11tho11yhea~11@digit.17Js.org
photographers we constantly seek subjects and
Tony Poole ARPS
ways
to express ourselves. From time to time we
D!GRO sub commilte
present
our results to audiences, whether to
to11_efpoo/e@google111ail.co111
intimate groups - that is to say, col leagues,
Rosemary Witman HonFRPS
discussion groups. camera clubs or fo lios - or to
preside1111ps@digit.1ps.org
the public in galleries. at exhibitions, on websites
Jim Buckley LRPS
etc. Yet the range of subject matter, treatment and
DlGlT Magazine
approach remains astonish ingly similar and
0 1932 843893
unadventurous. atural ly. one can take the view
edito1@digit.rps.org
that there's nothing new under the sun and
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DIGJT relies on the contributions of members.
We' re all !earning and your experience is valuable.
You don ·1 need to be an expert writer - we'll help you.
We need How To articles with your favourite digital
techniques and your brilliant images. Thank you.

Jim Suc/;ley L,f'P5 Edito1·

Emai I: etlitor@tligit.rps.org
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perhaps this is true. but there
are many ways of portraying
familiar subjects and, with a
lilllc imagination. discovering
how 10 present these things
anew. I dare say that we could
all identify a number of Clil'e flayues FIU'S
·
Chairmtm
photographic
and art1st1c
cliehes which could look something like the list
below. And. yes. I know - before you shout at me
- I confess that I've al o become a victim of many
of the cliches on the list:
- Cute picture of cats, dogs & kids
- Contrived. aggressive-looking youths set
against urban decay and brick walls
- Studio shots. including tramps and other
unlikely characters looking all too glossy
- The lone tree
ude draped over rock
- Glamour poses with coy-looking models
- ude in crumbling, desolate building
- Sweeping landscape/seascape with dramatic sky
- Abandoned room/house
- Slot Canyons
- Venetian Masks
- Panning shots of racing cars/motorcycles/sports
- First-class though omewhat static natural
history shot of birds on twigs
- Slow-shurter effects of flowing water/sea
- floral arrangements and close-ups of flower
heads
- Red hats/red umbrellas
- Sunset/sunrise (more points for getting up
early!)
- Reflections in windows of skyscrapers
Feel free to add more!
We all take these sorts of pictures and there·s
nothing intrinsically wrong about this nor do I
seek to be sweepingly highly critical. The reason
for my observation is th is: when we're presented
with typical examples of these genre images and
asked to judge or interpret them. it's ve,y difficu lt
not to fall back upon and automatically repeat
(often without realisi ng ii) the same old response as when a similar offering appeared before us.
When I see yet another lone rree. piece of rust,
patterned stone, abandoned cottage etc it's vc1y
difficult not to respond in the same ol<l way.
Indeed to find a fresh response to repetitive
subject matter is becoming something of a
challenge! Ifs no wonder therefore that the less
perceptive judges at club competitions find an
easy retreat into stereo-typical and mechanical
response. The subject matter and picture
frequently remain worthy but it's the viewer's
response that's the problem.
Perhaps we should endeavour not to repeat our
subject matter quite so frequently. A fresh
approach would allow us to better engage our
audience and judges too (please!) in a two-way
relationship to cha llenge perception and ga in the
informed response which. as aitists. we seek.

Clive #o/neS' ri(PS
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A Day with Steve Caplin
'A brilliant day and one of which we can be justly proud - a wonderful
shop window for the DI Group ' - Clive Haynes FRPS, Chairman.
With almost one hundred people
packed into the Smethwick Photo
Soc lecture theatre it was a
crowed day in more ways than
one.
Rosemary
Wilman
HonFRPS the new President of
the Society introduced the day by
open ing the International Print
Exhibition which was on display,
before rushing off to Chester to do the same for the
International Projected Image Exhibition.
Judges Martin Addison FRPS and John Long
ARPS gave a commentary on the prints which
members had brought and awarded prizes of
Martin's new book, Painter I I for Photographers,
and wine (thank you Gentlemen!) to Valentina
Kulagina ARPS and Peter Read LRPS for their
prints - see alongside.
More prizes were to follow in the next part of the
day as Steve Caplin, who produces satirical,
political montages for major national and
international print media talked about ethics and
image manipulation. He soon had us all wondering
just how we would push what we might feel were
the boundaries of acceptability in manipulation for
newspapers, and our o,vn pockets! Using examples
from both history (including painting and
photographs a century before Photoshop) and his
own work, Steve explored the moral issues which
confront us as photographers.
After the lunch break (i11 which Steve nipped
outside to take a couple of shots) he gave us his
views as an illustrator rather than a photographer on
the prints. And, guess what, he saw things
somewhat differently. Moving on to ilie images
which delegates had sent in for Steve's assessment,
he had some revealing points to make, including
taking care to scale human figures appropriately.

Digital Imaging Group

DIGITAL
REGIONAL
ORGANISERS
Contact the organisers listed
below for full details

Thames Valle)'
Roger Norton LRPS
www.rpsdig-thamesvaDey.org.uk

digro@rpsdig-thamesvalley.org.uk
East Anglia

Vacant
East Midlands
John Colmer ARPS
www.rpsdigital-em.org.uk
EastMidlands-DIGRO@tligit.1ps.org

Midlands
Clive Haynes FRPS
www.midig.org
clive@crhfoto.co.uk
North West
Harry Bosworth
hanybos@aol.com

He was impressed with the quality of D1 Group
members' work and gave a copy of his book to
Scotland
Geoff Coles Food
Vacant
for
Thought
(above) whilst the
Southern
bottle of wine went
Dr
Barry
Senior HonFRPS
to Brian Seaney
barry@litt/epicsfi·ees1ve.co.uk
FRPS.
Steve then took us
South Wales
on a fascinating
Maureen Albright ARPS
and interactive tour
www .southwales-dig.rps.org
of magic in Photoshop, covering Content Aware Wessex-DlGRO@digi1.1ps.org
Scaling, quick Selection, Blend If, Displacement
maps and much else. And Yes, it's in his book:
Wessex
How to Cheat in Photoshop. The most fun you can
Maureen Albright ARPS
have without breaking the law, said Steve!
www.di2w~org
Afterwards Steve told me: I enjoyed it hugely. What Wesse.x-DIGRO@digit.rps.org
an interesting and inspired group ofpeople. A real
Western
pleasure! Thanks.for inviting me.
Tony Poole ARPS
to11)fpoo/e@googlemail.com

DATES FOR YOUR DIARIES
NATIONAL EVENTS

Yorkshire
Robert Croft LRPS

18 April 2010: AGM, Smethwick Photo Soc
24/25 April 2010: Portraits, Fashion and Nudes Weekend, C heltenham

robert@robertcrofi.·wa,Uldoo.oo.uk

www.ydig.co.uk
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---- MABENDRA BHATIA LRPS

WATER COLOUR SKETCH
Like most of us, Mahendra Bhatia took snapshots of holidays, birthdays and the family
but when he retired from his full time NHS job in 2002 he booked into a Jessops
photography class. The lecturer, Leigh Preston FRPS, suggested he joined the
Cookbridge Camera Club in Leeds. In addition, he was fortunate enough to meet and be
taught Photoshop by Margaret Hockney - sister of the famous painter and user of
photographs in art, David Hockney. Mahendra moved on to LVS on line courses
(www.lvsonline.com/schedule.shtml) and before submitting his successful) L panel at
FOCUS he attended a Society workshop. In this article, he shows us a technique to convert
your photos into a watercolour sketch. This method may work best with jpegs with earlier
versions of Photoshop so convert RAW and TIFF files to 8 bit jpegs. Choose your subject
carefully since some look a lot better than others depending on the colours in the photo.
The s10,t i11g i11,r1ge
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palette (Ctrl+L) and
. .. CE:J
move the black and
Om:)
wh ite sl iders to give a
~
~
good line art effect.
///
The idea is not to have
e,,._
too much grey in the 11
,
"'
edges, so it looks like
,..
a sketch in black ink.
•
Now we'll prepare to
run the Dry Brush Filter on the middle layer. Click
the top layer (which is now monochrome) and
change the mode to Multiply to blend the top layer
with the layer underneath. the middle layer.
Now click the middle layer to activate it and go to
Filter>Artistic>Dry Brush. I used tbe settings 2. 2
and 3 for my photo of the orchid. You will need to
experiment to find the best settings for your own
- - - - - - , photo. Then
click OK.
The final step
is to adj ust the
paint effect.
the
Click
Adjustment
Layer in layers
palette
and
select Levels
from the list. Move the middle sl ider to the left or
right to brighten or darken the paint effect and
give the look you are after.Click OK and you' re
done!
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First duplicate yom photo layer twice by dragging
it to the Make ew Layer icon or pressing Ctr!+J
twice (Cmd+J on a Mac). Now you should have
three identical layers in the layers palette as shown
,--- -- - - - - - . on the right.
Now click on the top
layer to act iva te
it
and
choose
Filter>Stylize> F i nd
Edges.
Now bit Ctrl+Shift+U
to make your photo
monochrome.
You
can see this step on
the left.
To create the Art
Effect open the Levels
4
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Left:
Th e
finished
watercolour orchid

Below:
Watercolour Venice

Below: Street Artist
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BRIAN EACOCKARPS

Windy day in No,folk

THE LEVELS AND CURVES
OF MY SHORT
PHOTOGRAPHIC JOURNEY
Brian Eacock has been interested in photography for many years but it was not until he
retired that he was able to take it more seriously. Here he describes his interests and
experiences.
hen I was asked to write an article for the magazine
three things inm1ediately crossed my mind: shock,
horror and finally a sort of pride. But what am I
going to say? So once again my ever faithful motto, give it
your best shot, I I 0%. But heavens. how am J going to fill a
whole article with my thoughts and feelings on photography,
with no forma l train ing of any sort, and no years of experience
in the dark room? So what wi ll all the eminent and famous
authors who are members think about my comments?
J have always been interested in photography. that is to say, I
owned a camera that came out at least once a year, usually
with last year's fi lm in. When I retired from my job and
discovered that J could no longer run marathons or play
squash as I used to it became obvious that, with a replacement
hip. knee. and elbow. sadly golf was not an option.
1 was Clerk of Works at Worcester Cathedral for almost 30
years, not just a job. my life. But unfortunately it did not
include the use of computers, and I did not know how to
s"vitch one on let alone use one. So when I suggested to my
wife June that I was going to buy a computer, hilarity was
very much Lo the fore. But I did, and I struggled. Fortunately
JLme's son Alan is a top class TT consultant and always at the
end of the phone to so11 me out. That was when I started co

W
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notice articles about Digital Photography. After much reading
and studying l bought my first 3 megapixel digital camera. That
was it. l was hooked.
My next encounter was a short course on Photoshop with Cli ve
Haynes FRPS which presented even more challenges. l will
never forget that course: there were two professiona l
photographers who knew nothing about computers. and three
others who knew nothing about either computers or
photography. Clive had quite a challenge on. When I am
talking to people about my short time in photography I tell
them I am trying to squeeze a lifetime's photographic
enjoyment into a shon number of years. The best way I find to
do this by the "Levels. and Curves Method". l try and set the
LEVEL 1 wou ld like to achieve - very bigh - aud point out that
trying to master how to use the computer. learn about
photography. and the intricacies of Photoshop is a very steep
learning CURVE.
My next step was to join Beacon Camera Club where I \.vas
encouraged to enter the competitions and from then on
photography has become my passion. T later joined
Worcestershire Camera Club. the RPS Digital Group and { was
recently invited to join the Smethwick Club.
Now on my fifth camera. fourth computer. foui1h printer and
RPS DIGIT Magazine Winter 2009

Sunset over the M4

using the 2nd bedroom as a srudy, I am more than happy
with my kit. but at the start printing was a nightmare. I
knew nothing about profiles or colour management, and
the first printer which came ··free'· with the computer
cost an arm and a leg for the cartridges so yet more trial
and error, mostly error. Then success. l went to meet
Robin Whetton at PerrnaJet and he gave me great advice
and explained to me where I was going wrong. He and
all his staff were brilliant. I now use an Epson 2400 with
continuous ink tlow system and I use PcrmaJet paper
exclusively.
I have always been ve1y competitive person, especially
in my sporting pursu its and my motto in life has always
been to strive to do one's best no matter how unexciting
or menial the task may be. 110% every time. So why not
try fo r a distinction?
For my LRPS panel J had a variety of subjects bur for
my ARPS I conccnlraled on birds in the Nanire section.
I think I was more nervous sitting in the room at Bath
bearing the outcome of the appraisals. than I was when
I got married. The fact that so many failed on both
occasions made me even more proud to pass both
distinctions at the first attempt. Had I fai led the ARPS I
do not think I cou ld stand the strain of going through it
again.
When asked what is my favourite subject I immediately
say atu re (especia lly birds). Portraits. Seascapes,
Dereliction, Still Life. Arch itecnire - every one a
favourite. I j ust enjoy taking pictures of anything and
everything that I find attractive and would like to look at
again and aga in; and hopefu lly other people might enjoy
looking at as wel l.
The planned photo shoot does nol always turn out how I
envisaged but a spontaneous one is often brilliant. So
rather than concentrate on one subject I keep an open
mind and my camera at the ready. Invariably the sky is
washed out; the birds always seem to have something in
their mouth, move, or the wind blows as I click. I can
recall taking eve1y photo and the problems I
encountered. It is li ke looking through a diary for the
memories but instead of words, my photos tell my life
s101y.
RPS DIGIT Magazine Winter 2009

Wild in the wood

Michelle
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BRIAN EACOCKARPS

Kingfisher

The M4 i11 M o110
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I am not the most patient man in daily life but when
it comes to wai ting and taking Lhe perfect shot l can
sit for hours. I read all the a11icles in magazines in an
effo11 to learn and perfect my phot0s. I look at the
composition and subject matter - why did they
choose that shot? I try to look into the author's mind.
I do not always see the competition winner's
composition as my choice, but yes. occasionally I
think - ·'Yes I could try that".
When Alan. my stepson, offered to create a website
for me I was then faced with the decision of which
photos to display from lhe hundreds. nay thousands if
I am honest, r have taken over the past six years.
People have different perceptions of a good subject
matter so a variety was called for to cater for
everyone's taste. My website is at:
http://www.eacock.co.uk. I hope you find some to
your liking.
One of my early pictures that I gained a lot of
atisfaction from was completely out of the blue. We
were in Pembrokeshire on holiday when we
happened across some surfing championships. So
down to the beach I went with my trusty 70-300 lens
only to spot that the pros, from the surfing
magazines. had their 500, 600 lenses plus converters.
I felt a little bi t overawed. Anyway, I thought ·'give it
a go". I have always loved this shot (The Wave) and
it has done quite well in external competitions plus il
reminds us of Pembrokeshire. one of our favourite
places. We've been going there for 20 years but on ly
seen this event once.
The most evocative picture I think I have taken has to
be When you coming out to play? - our
grandchildren. Originally intended as a snapshot for
the fami ly album. I like to believe that this pictlU'e
will re-li ve the moment for many years to come, i.e.
Specia l birthdays I 8 and 2 I, and possibly a wedding
day. and will be passed around the family when
reminiscing about tbe birth of Jake.
Another favourite is Windy Day in OJfolk because
it reminds us of our first wonderful holiday in
orfolk. It was a ve1y simple shot, vast space,
enormous skies and far from the madding crowds. A
strnightforward, no messing about photograph wh ich
captured the momenL when we found this wonderful
scene1y.
My bird shots vary between snapshots spotted on our
walks, to days or weeks trying to catch a decent shot
of the "Kingfisher''. All my bird shots are rruly in the
wi ld (no visits to places where they tell you where
the bird is goi ng to land). When you mention to
people that you were !Tying to get shots of a
pa11icu lar bird, it is amazing how many people say
·'Oh we see one every day in the garden or at the
pool" or whatever. But when you t1y to narrow it
down it appears the last time they saw one was about
2 weeks ago. when he passed through al 30 mph. But
RPS DIGIT Maga7,inc Winter 2009
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Tlte wave

they are on ly trying to be helpful. Pan of my enjoyment is just seeing
the birds in their natural habitat and if I am able to get a good shot to
show for it that is a bonus.(see also "Pair of finches")
One of my few planned visits was to the M4 Bridge where 1 spent nearly
five hours from arrival to when I left in the dark. My shots stai1ecl with
early visions of sunset right through to when the lights came on.
("Sunset over the M4., and ·'The M4 in mono'').
I have recently been trying my hand at pot1raits. I started by using
daughters of friends, then the occasional studio session at the Midlands
DI Group. I recently joined Smethwick and have been to a few of their
studio nights. l find this very rewarding with a number of attractive
young ladies and with the lighting already set up. But the problem here
is time: for a beginner having only a three minute session to get a perfect
shot is difficult. However I have achieved a degree of success with
·'M ichellc" in a number of competitions. (See also ·'Wild in the wood..).
Having been in the construction industiy all my life. architecture and all
its characteristics from Norman Crypts lo derelict farmhouses have
always fascinated me. How were they built? Have they been altered?
And why are they fall ing down? I always try to picture in my mind the

When

yo11

coming

0111

to play?
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BRIAN EACOCK ARPS

Pair offinches

Scissor arch in nave

people who were bui lding rhese wonderful buildings. the
hardships and lack of amenities and the equipmenL LhaL is
now taken for granted. Sadly. in my mind, we are unable
to equal the sheer skill and workmanship of days gone by.
("Nonnan crypt" and "Scissor arch in nave").
What docs the future hold? As I sa id before I am trying to
cram 25 missed years of enjoyment into however many
years my failing joints will allow.
l am finding it increasingly difficult with mobility, and
wiLhout my wife June 's help with the driving and carrying
I would be lost. While on this subject I wou ld like to add

what an inspiration June has been to me: encouragemenL when I
needed it and infiniLe patience to cope with my lack of it.
1 really enjoy my camera club meetings ar Worcester and Beacon
and seldom miss one. The DI Group meetings at Smethwick are
always an inspiraLion with the varied speakers and demonstrations.
I support and enter all the club competitions. colour. mono and
digital projections, and enter a considerable number of external
competitions. Friends ask what about an attempr at a Fellowship and
my response is: That is one of my dreams. People can have dreams
can't they?

10
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TONY HEALY ARPS

THE NEW BUZZ WORD IS
TOPAZ
For years, people who wanted to use simplifier software on their images used buZZ but
this is no longer available. In this article, Tony Healy discusses an alternative,Topaz.
n the Spring 2009 issue of DIG IT (No. 4 1. pp 8-1 1)
Alan Dedman mentioned that one of his major
Adobe
Photoshop
plug-ins
was
buZZ.
Unfortunately the company that produced this plug-in
went out of business leaving those yet to experience
this feature without a chance to do so and those who
had demonstration copies unable to buy an activation
key to use it beyond the trial period. I found myself in
the latter group. Alan had a fo llow-up article in the
Autumn 2009 issue of DIGIT (No. 43, pp 28-29) with a
brief comment on the application and an example of
Topaz Simplifier. However it is a case of the "King is
Dead, Long Live the King". An alternative and more
flexib le replacement has arrived called Topaz Simplify
2.
The manufacturer states that their product:
• Creates artistic simplification and edge effects on
reg11/ar photos i11 a 1111iq11e way
• l11sta11t(v transforms your photos into breathtaking art
with its innovative Photoshop plug-in
•Allows you to take control of the artistic process with
i11fl11itely customisable and malleable options
•Requires 110 drawing skills - using simple. quick and
easy-to-learn sliders
•Maximises yo11r time by using presets or make yo11r
own favourite settings
•Operate with both 8-bit and 16-bit mode
•Utilise Photoshup's Smart Filter.feature.for cu11ve11ielll
and 11011-destrnctive editing
•ls fully compatible with Photoshop CS4 64-bit and the
acco111panyi11g speed benefits
Well that's quite a list but I have to say it does offer a
few benefits over buZZ.
The first thing you notice is the larger window size you
have to work with in Topaz. You have the option of
"Fit" to Window or " I 00%" with any percentage in
between and up to 400%. The controls work from left
to right and are laid out in a logical worktlow.
The yellow atTows in Figure I indicate the position of
data about the image size. The left hand arrow head
pointing at "Preview Mode" is showing that the image
is displayed at less than I00% by using the term
"approx•·. This is also confinned by the next small
a1Tow to the right which points to the specific image
size. The last arrow point indicates the button to display
the image at I00%. Once th is is chosen the "approx''
word at Lhe first a1rnw head changes to "accurate".
Figures 2 and 3. respectively. show the "Fit'' size and
how you can fill tbe window using the "+·• button next
to the I 00% button.

I
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Figure I

Figure 2

Figure 3
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Fig ure 8

In Figure 4 there are 3 Yellow Xs above "combined image" , "base image" and
" edges" . The "combined image'· option shows the changes made combined
with the edge data generated by the changes. The "Base image" shows the
simplified image on its own and "Edges" shows the line image that has been
generated by changes. The two arrow heads indicate the "preset" button and the
Iisl of ·'presets'· that can be accessed. If you create your own set of changes and
do not use the presets then you can save the steps and add it to the list that is
already there.
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There is a strip located on the
right hand side of Figure l seen in
close up in Figure 5. From rop ro
bottom, c licking "OK" commits
all changes and opens the image
in Photoshop. "Cancel" obviously
cancels all changes. Tbe "Help"
button will connect you to Topaz
Labs to learn more about the
appUcation. ff the "Enable pop
up" box is checked whenever you
place your cursor over a slider or
button a pop up bubble w il l
appear as in Figure 6 to tell you
what the function does. The large
" View Original Image" button is
a toggle between the modified
image and the original image. The
"share" button creates on the
c lipboard the list of changes that
have been made to an image that
can be pasted into a document.
sent to a friend via email or
posted on a web site. Finally
"Reset All" sets everything back
to their defau It settings.
We now come to the engine of the
pl ug-in. Figure 7 shows the
settings you will use to create
your work of art. The "Simplify"
tab brings up the sliders to make
your changes. Although you will
work i11 RGB colour space the
simplification can sometimes
create odd colour patches and
changing to YCbCr colour space
can remove them. The sliders in
the "Simplify" tab allow control
over how much of the original
image you want to simplify. It is
used in conjunction with rhe
"'Adjust" tab to bring out detail
that would nom,ally be lost using
the "Simpl ify" slider alone.
Work can be done in both a colour
mode and a B+W mode. Figure 8
shows the list of options, and you
can decide whether or not you
want a positive or negative image
by clicking on the ·' Inverse Edge
Colour" box. Figure 9 ill ustrates
the two options.
While I was in the process of
writing this a1t icle Topaz Labs
upgraded the software to version
2. The interface changed and the
"presents" which were just listed
below the sliders now appear with
their effect down the left hand
side of the interface. Figure 10.
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Figure 9
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Figure 11

Figure 11 is an original image of a Fiddler
Beetle so named for the pattern on its back.
Two variations of this image are Figure 11 a
and Figure 11 b. The first variation is using
Topaz Simplify 2 on the whole image and
Figure 11 b has the beetle modified and the
original background flowers
Figures 12. 12a, and 12b show the original
image together with two variations using
Topaz.
Figures 13 and 13a (page 16) show the
difference between just a simplification
and using the detailed boost feature. It is
most noticable in the bottom left hand
comer.
This article was intended to alert members
to this software and not act as an
instruction manual
To get a broader idea of the features view
the
exce llent
video
tutoria l at
b ttp ://www.topazla bs.co m/ tutor i al s/

Although at the time ofwriting this tutorial
deal t with version I all of it also applies to
version 2. No doubt when a version 2
tutorial becomes avai lable it wi ll cover all
the new features.
For Mac users who wish to have a copy of
the video tutorial to keep and view
whenever they wish on their computer
there are two methods. For those still using
TIGER download a free copy Real Player.
(http://www.real.eom.au/ mac/?lang=
en&loc=a u). This will pul the video data

Figure 1/a

in cacbe and give you the option of saving
it when the video has finished.
For those using Leopard start to view the
video in Safari and pull down the
WINDOW>Activity. If you don't see a Iisl
of files click on the triangle beside the title
to expose them. Wi thin the list will be one
that is increasing in size as you watch.
Copy this line and then paste it into
WTNDOW>Download. This wi ll cause
Safari to download a copy of the tutorial to
your desktop or download file. It can then
be viewed in Quicklime at your leisure.

Figure llb
14
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Fig ure 12 Original image

Figure I 2 " Simpl(fied

,..;,1, Topa:
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Fig ure 12b W<1ter colour preset in Top<1:
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Figure 13 Image simplified

Figure 13a Image using dewiletl boost
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WEBWISE 7 with David Cooke ARPS
All the Webwise material is on the new DI Group Forum which is located within tbe main RPS
Fortun. You'll need to register to make comments and to contribute. Details of how to do this are on
the main RPS DJ group page at http://www.rps.org/group/Digital-lmaging. Please do make a
comment on the Forum or email me at digitwebwise@gmail.com to let me know how usefu l (or not)
you found the sites recommended. And please do recommend s ites you've found interesting yourself
so other members can share them.

Welcome to the 7th edition of Webwise.
This time we have three websites and a
podcast. I hope you find them all
interesting and useful.

Entheos
http://www.entheosweb.com/default.a sp
Entheos is a five-year-old Web Design
company based in Bangalore, India. They
have a very comprehensive web-site which
gives details of their services but it a lso
contains some very useful free resources at:
http://www.entheosweb.com/
free_resources.asp
They include tutorials on Flash,
Dreamweaver, Fireworks, web design and
web promotion. There are also free Flash
add-ons, website templates add-ons and
brochure
backgrounds.
logos.
and
templates.
It 's a very useful resource and
recommend that you take a look at it.

I'd

Photoshop Roadmap
http://ww,v.photoshoproadmap.com/
As its name suggest, Photoshop Roadmap
contains resources for Photoshop. These
include written tutorials and videos as well
as free downloadable brushes for example
water, leaves and trees, seashells and eye
brushes. In addition, there are reviews on
plug-ins.
It's another valuable resource which may
contain something of interest to you.

London independent photography
http://www.londonphotography.org.u k/
London Independent Photography is a
forum for both amateur and professional
photographers. It has around 500 members
and a very interesting website. One feature
I'd like lo draw your attention to is that
they have back copies of their magazine up
to issue number 7 (Summer 2007) available
for free download from their site. Go to:
http://www.londonphotography.org.uk
/LlPmagazine.php
and cl ick on the back issues archive links
RPS DIGLT Magazine Winter 2009

on the right hand side of the page.
The magazines are very interesting with
good features and images. They are well
wo1th looking at.

Jeff Curto's Camera Position
http://www.cameraposition.com/
or subscribe through iTunes
Jeff Curto is Professor of Photography at
College of DuPage in Glen Ellyn, fllinoi s,
where he has taught since 1984. Since 1989,
he has been photographing the architectura l
landscape of Italy, exploring the visual
splendour of its religious, public and
vernacular structures.
As he says on the site: "Camera Position is a
podcast about the visua l and creative
processes in photography, not the technical.
Using images and the spoken word, my
podcasts are about the "why" of
photography from the point of view of the
creative photographer. Passion for subject,
experience and image all wind together in
these short commentaries about camerabased images and my life as a photographer.
The podcasts are presented as enhanced
podcasts; they have images embedded in
them so there are visuals that accompany the
audio."
You can watch tbem on the Camera Position
website or you can subscribe via iTunes.
They are reflective and interesting podcasts
and l hope you find them interesting.

An invitation
If you'd like your website to be featured in
future Webwise articles then please email me
at digitwebwise@gmail.com with details of
your site and let me have a few words about
your photography. It could help to put you in
touch with like minded photographers.
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Making 3D Pictures
The Red/Cyan Method - Anaglyph
Recently there's been a resurgence of interest in stereoscopic image making with
cinema films and television adopting the technique. Here Clive Haynes FRPS explains
how it's possible to introduce the th ird dimension using digital imaging techniques
available to all of us. To see the pictures on these pages in 3D you'll need the free red
and cyan glasses that are in the centre of the magazine. If you misplace them you can
buy further pairs from 3D Images Ltd - see box on page 21.
hat is a 3D image? The human optical
system views a scene and transmits
messages to our brain which are the
contents of two simultaneous. two-dimensional
images. spaced about three inches apart. In
making a 30 image we need to convince our
optical system that. just as in real life. the two flat
images presented add together to make a
stereoscopic (JD) picture.
In Victorian times bioscope scenes viewed with a
hand-held stereo viewer were very popu lar. Two

W
AboFe: Bicydes
18

pictures were taken of a scene and pasted together
side-by-side for viewing through simple lenses.
They were \'ery good. with excellent depth and
clarity.
How to do it. The first requirement is to take two
pictures of the scene, one left, one right.
Obviously unless you arc using a specialist stereo
camera, it's best to avoid scenes with movement.
The viewpoin t fo r pictures for most normal
scenes, using say a 35mm to I00mm focal length
lens (as per 35mm photography) needs to be about
RPS DIGIT Magazine Winter 2009

3 inches apart - this is the average distance
between the left eye and the right eye. Special
devices can be bought to do this with extreme
precision: however it can be done quite
successfully by simply moving the camera. To do
this take one picture (left) then lean to the right a
little - go about 3 inches (75mm) keep everything
level and. without twisting the camera. take the
second shot (right).
Toeillg-i11 An improvement upon the simple
'move to the right' method can be made by roeingin. This is what you do. When taking the left (L)
shot, look at the centre of the scene area for a
reference object and remember where it is within
the frame. Move the 3 inches to the right (R) and
pan the camera back into the original scene area this is toeing in. Place the reference object in the
same spot as it was in the left image. Take the
shot.
The s light pan almost re-aligns the image
elements. However, they remain d isplaced by 3
inches to the right and this gives the stereo effect.
The toeing-in is to reduce the amount of image
area that spills beyond the frame of each shot
when combined in the anaglyph. In this way a
more complete image area is retained. Act11ally it's
far easier and more obvious to do than to explain!
Note: For wide-angle lenses you'll find that it's
often preferable to reduce the L to R separation
and ignore toeing-in. This is due to the
exaggeration and distortion of perspective by
wide-angle views. For longer focal length lenses L

RPS D IGIT Magazine Winter 2009

to R separation wi ll need to be greater than 3
inches. Indeed for distant scenes with long
telephoto lenses the separation may be several
feet. However, with greater separation it's more
difficult to maintain correct registration. You'll
need to experiment.
Work ill RGB (colour) m ode Finally, 1
recommend using a colour image as the image
w ill be avai lable for either colour or 3D stereo use.
Also, for monochrome, the tone and contrast can
be adjusted to suit the subject and aid spatial
separation. Any Greyscale images must be
converted to RGB before beginning the process
outlined below.
A ll A uaglyph A popular form of 3D picture is a
two-colour image that recreates depth by making
each ha lf of the stereo pair a different colour; this
is known as an anaglyph. For many years red and
green was the most common combination.
However. now red and cyan are more often
preferred. Using red/cyan makes it easier to view
colour images in 3D as more colour infomiation is
reta ined. The accepted convention is to make the
image for left eye image red and for the right eye,
cyan.
Digi ta l imaging has made the production of
anaglyphs simple.
By the way, the word anaglyph. derives from the
Greek - anaglyphos, anaglyptos - in low relief ana, up/ back. g lyphein, to engrave or carve.
Anaglypta wallpaper has the same derivation!

Clive says:
I hope that this
introduction to making
stereo pictures will
encourage
you
to
explore the subject - it's
a fascinating topic. For
more infonnation visit
the 3D Images Ltd
website (see page 2 l)
and the Stereoscopic
Socie t y:

stereoscopicsocie~1.org.uk
The Know How section
of my website has
about
information
making 3D Anaglyphs
other
and
many
tecbniqucs

www.cr-hfoto.co.uk

Beluw: J/ti,es mu/ Hflt
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Above: Welsh landscape
This is the 1110110 infrared
image which Clive cretaed
using the steps 011tli11e1/
alongside

Below: Channels Palette
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Making a11 A11aglyph (red/cyan) JD picture What
follows looks long-winded because l've detailed
every step. ln practice the whole process is very
quick and I can run through it all, from opening
the images, to the final 3D version, ready to print,
in less than two minutes - honestly!
Start with a monochrome 3D image to get used to
the idea, then have a go with colour and miss out
desaturntion in steps 3 and 9.
Before you begin, make certain that the Channels
palette is visible: if you can' t see it, go to Window
> Channels.
I Open the L and R images in Photoshop in the
usual way. Save your RAW or j peg files as
Photoshop (.psd) files. With jpeg files the
Duplicate Channel fu nctions listed below will not
work correctly.
2 Make any obvious corrections, bearing in mind
that the two images will ultimately overlap each
other to fonn a single opticaJ composite. Do not
make any alterations to the pixel dimensions
either by Cropping or T ransformation at this stage.
ff alterations are made the Duplicate Cham1el
functions listed below will not function correctly.
3 Go to the L image and de-saturate it. Do this
using Image> Adjust > Desaturate (Ctrl+Shift+ U)
4 Go to the Channels Palette and click on the RED
Channel - it highlights in blue. At all times for this
method, when activating the required Channel.

keep each eye icon visible fo r all Channels.
5 Go to the drop-down menu anow at the top right
of the Channels palette and click. rn the menu that
opens choose Duplicate Channel.
6 In the dialogue box that opens go to the
Document box and click on the drop-down anow
and choose New.
7 In the Name box (not -:-::,
the Document box) type ;,,,:;_
in the na1ne of lhe i111age C: -°"'°
you are working on. ff
_ ,,. _ _,,.,,,_
you've already saved the Above: Naming the 11ew
L and R originals then Duplicate Cha1111el
choose another file name otherwise the system
may not accept it. Click OK. A new monochrome
(Alpha Channel) image will appear
8 Minimise or close the L origi nal. Keep the new
Alpha C hannel (monoclu·ome) image open.
9 Go to the R image and Desaturate it. Do this
using Image> Adjust > Desatura te (Ctrl+Shift+ U)
10 Go to the Channels Palette and click on the
GREEN Channel - it highlights in blue.
Remember to keep all the eye icons visible.
I I Go to the drop-down menu aiTow at the top
right of the channe ls palette and click. In the menu
that opens choose Duplicate Channel.
12 This time in the dialogue box that opens, go to
the Document box, click on the drop-down arrow
and choose (click on) the fi le name you gave in
10

L . __ _ _ _ _ ____.
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without detriment to the
step 7. Click OK.
13 Go back to the R original and repeat steps 10, image.
11 and 12 this time selecting the BLUE Channel Tonality: Use either
Levels or Curves via an
in step I 0.
14 Minimise or close the right original.
Adjustment Layer.
15 Go to the Channels Palette and make certain Re-alignment: Should
that all the eye icons for the Red, Green and Blue the two Red/Cyan image
Channels are visible. The (monochrome) Alpha Channels be misa ligned
Channel image, created from the three separate then some adjustment is
colow- Channels (red= L. green and blue (cyan) = R) possible. Tbis is best
will appear as overlapping images with a pi11k hue done with the Red
and not stereo-looking at all. The three Alpha Channel only. Go to the
Channels have created a Multichannel image and Channels Palette and
the
we need to change this to RGB. Go to Image > activate
Red
Mode > RGB and, as if by magic, the Channel. Click on the
monochrome image becomes a red/cyan eye icon in the RGB Channel - this automatical ly
opens the Green and Blue Channel eye icons too.
anaglyph!
16 Put on your stereo red/cyan spectacles and Next, Select All (Ctrl+A)so that the ' marching
ants' appear around the image border. Choose the
view in glorious 3D.
17 All should be well but some adjusm1ent may be Move tool and adjust the positioning by the four
direction-arrow keys on your keyboard. This will
necessary. See tweaks below.
18 Print the picture on semi-gloss or matt paper as incrementally shift the Red image up/down, left/
reflections from a glossy surface may be right. Shifting left or right will decrease or Green Clumnel
distracting.
increase apparent spatial separation. Viewing with
the grid visible (Ctrl+@) will he lp to align
Tweaks and adjustments
To make global changes to the image, be certain to accurately.
use the Layers Palette, otherwise if you remain in If necessary, the image (Red Channel) can also be
Channels you may find that you are adjusting one rotated - do this using Edit> Transfonn > Rotate.
However, remember to Select All (Ctrl+A) first.
colow- Channel only!
Sharpening: Use your preferred method at an Deselect (Ctrl+ D). Use the Crop tool to remove
appropriate level.
unwanted sections of the image beyond the JD window.
Brightness: As viewing through red/cyan Wh at sort of pictures work best? In my
spectacles can darken the scene, extra brightness experience the scenes that work best have many
is often required. This can be done using an planes of image information. are of a gentle Above: Mode clumge
Adjustment Layer using Brightness and Contrast. contrast range and avoid large, dark, fearureless
However, depending upon the image. Levels or areas. Dark areas frequen tly reveal ghost images
Curves may be preferable. Adjustment Layers are from the other Channel which can be a distraction.
best for the task as they can be altered later
Wh ere to get th e JD
spectacles For a wide
of 3D-related
range
producrs go ro 3D Images
ltd, 31 The Chine, Grange
Park, Lo11do11, N21 2£A
Tel: 0208 364 0022/0/04
www.3 Dim agcs .co .uk
We rhank Dr Dm•id Burder
FRPS of JD Images for his
valuable advice and
supplying JD specs for this
edition of DIGIT.
Please noie: This merhod
is imended for direcr
viewing 011 the monitor
screen or printing by inkjet primer. Co111111erciaf
printing processes may
degrade or distort the JD
image1J'. Some images
may therefore appear fess
s11ccessf11f
to
some
viewers.
Orgues (//1(/ B room
3D Colour im age
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Notice of AGM and Exhibition Print Selection
with a talk by Mike McNamee FRPS on The Impact of Digital Imaging on t he Creative Process

The Annual General Meeting of the RPS Digital Imaging Group will be held at
1030 on Sunday 18 April 2010
at The Old School House, Smethwick PhotoSoc Club Rooms,
Churchbridge, Oldbury, West Midlands 8 69 2AX
Easy access from MS , Junction 2 or train to Sandwell and Dudley.
See http://www.theoldschoolhou se.com for club details and map

2
3
4
5

6
7

Coffee available from 1000
AGMAGENDA
Notice of meeting
Fo1mal adoption of minutes of 2009 AGM
- see website for minutes
Matters arising from the previous minutes
Annual Reports and Accounts:
- Chairman & Treasurer
Election of Officers & Committee
- see overleaf for vacancies
and Nomination Form
Any other relevant business
Date of next AGM
T he AGM will be followed a t a bout 1100 by th e Selection of P r ints for the Ex hibition
1300 Hot lunch or vegetaria n, which must be pre-booked, available in the lounge. L icensed ba r.
O r bring your own lun ch
1400 - 1630 Mike McNameee FRPS on T he lmpact of Digital Imaging on the Creative Process

Coming from a background in which he had bee n trained as an airbrush retoucher, Mike will discuss the impact that digita l cameras a nd digital manipulation
have had on the creative process, with some ideas for concept gcner:11ion and demonstrations of Photoshop execution. Today's tools allow for ideas that were
previously only possible to express by brush-painting onto pa1>er 01· ca nvas. £,~0 cry so often we need 10 take stock of just how well-served we are today and
how we cnn exploit th e situation 1>:irticularl) for compcr it·ion and high-impact images.
Free for· G roup members - tickets fo r others £5 on the door

Please cut !,ere to use the hooking slip below for lune!, or photocopy the booking slip

..... ·-·- ·- ·-·-·-·- ·- ·- ·- ·- ·- ·- ·-·- ·- ·- ·- ·- ·- ·-·-·- ·- ·-·-·- ·- ·- ·- ·- ·- ·~
Hot or vegetarian lunch availa ble a t £7 per head. Booking and payment to be made by 5 April.
Please book me:
hot lunches
Vegetarian lunches at £7 each

D

D

C heque enclosed for£

D

Stamped a ddressed envelope enclosed - please tick:

D

Na me: - - - - - - - - - - - - - - - - - - - - -- - - - - - - Address:

- - - - - - - - - - - - -- - - - - - - - - - - - - - -

Email address:

----------------------------

Please return booking slip with cheque to RPS DI Group and SAE to:
Bob Pearson FRPS, Orchard House, Broadhembury, Honiton EX14 3LW

ANNUAL GENERAL MEETING: COMMITTEE FOR 2010/11
The AGM provides the opportunity to elect the committee which comprises the four officers laid down in the
constitution and six further members who may also have specific responsibilities. The President, the Secreta1y
and the Treasurer of the RPS are ex officio members of the committee and are additional to those elected. DI
Group Regional Organisers are also encouraged to make their contributions to the committee.
The positions for which elections will be held, together with the names of the current committee who offer
themselves to stand for election at the AGM are:

Six Committee Members:
The fo llowing offer to stand:
Maureen Albright ARPS
David Cooke ARPS
Alex Dufty LRPS
Anthony Healy ARPS
John Long ARPS

Officers
The following offer to stand:
Chairman: Clive Haynes FRPS
Deputy Chairman: Graham Whistler FRPS
Secretary General: Bob Pearson FRPS
Treasurer: Elizabeth Restall LRPS

DIGROs
Thames Valley: Roger Norton LRPS North West: Harry Bosworth South Wales: Maureen Albright ARPS
East Anglia: Vacant Scotland: Vacant Wessex: Maureen Albright ARPS
East Midlands: John Colmer ARPS Southern: Barry Senior Hon FRPS Western: Tony Poole ARPS
Midlands: Clive Haynes FRPS Yorkshire: Robert Croft LRPS
Nomjnations for election to the Committee and for Officers should be put forward in writing by not less than two
other members of the Group and such nominations must be received by the Secretary not less than fourteen days
before the date oftheAGM. Nominations must be accompanied by the written consent of the nominee. In the event
of the number of nominations being greater than the number of vacancies, an election will be held at the AGM.
Assistance continues to be needed from outside the committee to encourage and spot potential articles and images and
to help with copy preparation. Please contact the editor David Cooke ARPS if you can help, on editor@lligit.rps.org

Please cut here to use the Nomination Form below
or photocopy the slip for more than one nomination

ROYAL PHOTGRAPHIC SOCIETY DIGITAL IMAGING GROUP
NOMINATION TO FILL VACANCY ARISING AT THE AGM ON 18 APRIL 2010
TO BE RETURNED TO THE SECRETARY BY 1700 ON 4 APRIL 2010
I,

- - - - - - - - - - -- - - - - - - - -

(Please print)

wish to stand for e lection as : - - - - - - - - or to the Committee.
Signed _ _ _ _ _ _ _ _ _ _ _ __

Date: - - - - - 2010

Proposed by: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ (Please print)
Signed _ _ _ _ _ _ _ _ _ _ __ __

Date: - - - - - 2010

Seconded by: _ _ _ _ _ _ _ _ _ _ _ _ _ __ _ _ (Please print)
Signed _ _ _ _ _ _ _ __ _ _ _ __

Date: - -- - 2010

Please return nomination form by 1700 on 4 April 2010 to:
Bob Pearson FRPS, Orchard House, Broadhembury, Honiton EX14 3LW

DIGITAL IMAGING GROUP

2010 MEMBERS' EXHIBITION

The 2010 print exhibition wil1 be shown at the foUowing locations:
Northlight GaUery, Brooke's Mill, Armitage Bridge,
Huddersfield, West Yorkshire HD4 7NR
www.northlightgallery.org.uk/
The Gallery is open on Fridays, Saturdays and Sundays
4, 5 and 6 June.
11, 12 and 13 June
18, 19 and 20 June
West Swindon Library, Link Centre, Whitehill Way
Swindon SNS 7DL
Thursday 1 July until Friday 30 July during Library opening times
Closed on Mondays
Smethwick Photo Soc, The Old School House, Churchbridge, Oldbury
West Midlands B69 2AX
Monday 16 August to Monday 30 August
Any changes or additions will be displayed on the Website
Closing date for postal entries: Thursday 8 April 2010
Selection of Exhibition: Sunday 18 April 2010
You may bring your entry to the Annual General Meeting of the Digital Imaging Group,
to be held at the Old Schoolhouse, Oldbury, West Midlands on Sunday 18 April 2010. But
you must send the Entry Form overleaf, your CD and cheque to Alex Dufty in advance.
Selectors:
Andy Beel FRPS
Paula Davies FRPS
Mike McNamee FRPS
Please read the rules carefully and complete the Entry Form overleaf
Any queries, please contact the Exhibition Secretary, Alex Dufty LRPS
127 Bradley Avenue, Winterbourne, Bristol BS36 lHW
Tel: 01454 778485
Email: exhibition@digit.rps.org
For Membership, News, Information, Folio, Forum, Competition and much more
- Log on to www.digit.rps.org

2010 MEMBERS' EXHIBITION - RULES
1. You may enter either TWO or THREE prints.
2. Do not enter prints which have been accepted for previous DIG Exhibitions.
3. Mount your prints on 40 x 50 cm card.
4. Mark each print on the reverse with your title, name, address as on the entry form.
5. Make copies of your two or three images as single layer TIFFs in Adobe RGB (1998) colour space, exactly
2400 pixels on the longer side - that's about 20cm at 300 ppi - if you want your images to be published on the
website, in the Exhibition DVD and in the Exhibition issue of DIGIT. Ensure that the file names are exactly as
on the entry form.
6. Burn a disk with your images and write your name and image titles on your CD with a suitable marker.

Entries for the Exhibition without the CD and files in the correct format will be accepted for the print exhibition but, regrettably, the images may not be able to be published.
7. Complete the Entry Form below and your cheque for £5 to RPS DI Group to cover the exhibition costs.
8. Post or deliver your prints, CD, cheque and entry form to Alex Dufty LR PS - see address on reverse
OR
Post or deliver your CD, cheque and entry form to Alex Dufty LRPS - see address on reverse and bring your prints to the AGM on 18 April 2010.
9. Ensure that the packing is suitable for use in return posting of the prints unless collection arrangements have
been previously agreed with the Exhibition Secretary. Remember to include return postage stamps or cheque.
10. Selection will take place following the AGM on 18 April 2010 by the judges listed overleaf. Each entrant will
have one print accepted. A Gold Medal and six Ribbons will be awarded.
11. It may not be possible to display all accepted prints at every venue.
12. The utmost care will be taken of all prints but the Digital Imaging Group cannot be held responsible for any
loss or damage during the exhibition or whilst in transit.
ENTRY FORM - 2010 MEMBERS' EXHIBITION
Name:

RPS Distinction:

Address:

RPS Membership Number:

Tel:
Entry fee of £5 enclosed:
Return postage enclosed:
PRINT TITLES
1.
2.
3.

E-mail:

(write carefully please)

DR JAKE L SNADDON

PINHOLE CREATIONS
Jake Snaddon enjoys using homemade and commercially available pinhole cameras to
produce 'raw' images for subsequent digital manipulation. Here he describes the basis
of pinhole photography and how to make a camera. He presents some of the images he
has produced in sequence from some of the first ones made to the latest and most
manipulated images.

Study of house plants; Kidz/abs pinhole camera; 2 minute exposure

inhole photography is the art of taking a
photograph without using a lens. Instead the
lighL passes through a small hole in the front of
the ·camera', which is often no more than a
lightproof container. The absence of a lens gives
pinhole images distinct characteristics - they have a
nearly infinite depth of field. a soft focus from
chromatic aberration and long exposures, and can be
heavi ly vignetted. These qualities give pinhole
photographs their much loved appearance and
together with the experience of building your own
camera. producing a pinhole image can be a very
creative endeavour. The experience does not have to
end there, as these images make great starting points
for digital creations.
Since the l 960s pinhole photography has become
increasing popular. There are now dedicated
websites, forwns, workshops and even a Worldwide
Pinhole Photography Day (WPPD) (see the link at
the end of this article). This annual event is held on
the last Sunday of April, when pinhole photographers
are encouraged lo submit and share an individual
image they have taken on that day. It started in 2001.
when the first WPPD attracted 291 participants from
24 countries. This has now grown substantial ly, with
3202 participants from 69 countries each submitting
individual images to this year's event. Tbe success of
the WPPD illustrates just how popular pinhole
photography has become.
The beauty of pinho le photography is in its
simplicity. wi th the requ irements of the camera being
a lightproof box, a pin-sized hole and some sort of
photosensitive surface. This means you can easily
build a camera at home.

P
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There is a great deal of choice when deciding on what type of
containers and what type photosensitive surface to use. Using
different containers will result different effects. for example a
tubular container such as a can, where the film or paper is curved,
will produce a distorted perspective. Some of the more commonly
used containers are soda cans, oatmeal boxes, film canisters and
matchboxes. Any lightproof container has the potential to make an
excel lent pinho le camera and there are some unusual examples
including seashells, gasmasks and even an abandoned aircraft
hangar.

Self Portrait; Mlltclt Box pinhole camera; 30 second exposure
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As you are making the camera yourself the whole
range of film and photosensitive paper is avai lable
to use. My preference has been to use 35mm film
as it is readily available and can be easily
developed at any local processi11g lab where they
can transfer the images into a digital format on a
CD. [f you do not want to adventure into making
your own camera out of your latest shoebox. or are
still waiting to fmish off your oatmeal, there are a
number of commercial pinhole cameras on the
market al both the toy camera and professional
level.
[ became interested in pinhole photography wbj le
working with my digital images; l often found I
ended up manipulating the pictures to incorporate
a pinhole or vintage camera effect. So I thought
that I would try producing the ' raw images· the old
fashioned way.
My ambition was to take the pictures with a
camera T had built myself. However. not having
any experience with this type of photography 1
first went out and bought one of the many toy
pinhole cameras on the market, mine was the
'l(jdzlabs· pinhole camera. This camera is very
simple; it is a black plastic box with a spring
loaded shutter and takes 35mm film. The pinhole
is made through a thin piece of aluminium stuck
onto the inside of the camera. Finding it hard to
believe that a very small hole would produce an
image, I made the mistake of making the pinhole

too large and the images from my first role of fi lm
(Study of house plants) were more out of focus
than I would have liked. I was able to replace the
aluminium and make a pinhole of a smaller size
which produced much better results.
Feeling I had made progress with the technique, l
constrnctcd my first homemade camera from a
matchbox. Briefly, to make a matchbox camera
you will need: a matchbox, t\VO rol ls of 35111111
film (one new and one discarded roll with at least
I cm of film sticking out), a piece of th in metal
(e.g. from a soda can). and black PVC electrical
tape. The fi lm from the new canister is threaded
through the box and attached to the old discarded
roll. The inside part of the box, has a rectangular
hole cut in the bottom to form a frame tbat holds
the film flat against tbe back of the 'camera ·. A
small hole is made in the front of tl1e box over
which the thin meta l with the pinhole is placed.
These separate parts are joined together with the
PVC tape. making sure that it is all lightproof.
There arc excellent resources online on how to
make different pinhole cameras from a whole
variety of containers. For more details on how to
make a pinhole camera out of a match box see the
link at the end of this article. The matchbox
camera has become a firm favourite, as they are
quick and easy to make and their size means Tcan
carry them around with me with little trouble.

Snow covered Jesus Green, Cambridge: Match Box camera; 2 minute exposure
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One of the goals for pinhole
photographers is to produce a sharp,
well exposed image. However, as
the cameras don't have the technical
settings which are common to
modern cameras (there are no
buttons or dials for different f-stops
or for shutter speeds) it takes a bit of
trial and e1Tor to learn how to get the
best results from your individual
camera.
While you are still learning, you get
many over exposed shots. It would
be hasty to throw these away as with
dig.ital manipulation software
programs like Photosbop and
Lightroom you can rescue a lot of
the detail and create some very
interesting effects. When I get my
images processed, instead of getting
them printed I have them put
straight into a digital fonnat on CD,
which enables me to treat them as
'raw images' that I can then enhance
and creatively manipulate through
post processing.
As an example of digital
of
pinhole
manipulation
photographs I would like to describe
the development process for a

Reading books; Match Box pinhole camera; 10 minute exposure

lrchel Campus University of Zurich; Match Box camera; 2 minute exposure
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The Se(lgulls I; J\l(ltch Box c"mem ; 2 minute exposure

The Se(lgulls 11; digit"/ 111a11ipt1/(ltio11 of 'Se"gulls I' using Silver Efex Pro filters, Nik software

Lonely C/wir; Match Box camem, 2 minute exposure, digital()' manipulated using
Nik software
30

couple of the images in this article: The Seagu lls
II and Rorschach pinhole. The Seagulls II image
was created from the original The Seagulls I
photograph, w hich is of porcelain seagulls
hanging on a mobile at home. The original image
was cropped to give the letterbox aspect ratio,
with tbe seagu lls on the left. r then used the N ik
software plug-in for Photoshop, called Silver Efex
Pro. This plug-in a llows you to apply filters to
create black and white images with different
effects, (ironjcalJy Silver Efex Pro. includes a
pinhole effect filter). Each filter has a number of
adjustment bars allowing the fine control over
how the fi lter is applied. One of the great things
about this software is that you don't have to apply
a filter to the whole image. You can use control
points to select where you want the effect or you
can paint the effect in or out. The fi lter J used for
this photograph was · Antique Solarization' , where
I adjusted the brightness, contrast and structure.
The second example is the Rorschach pinhole, the
last picture of this article. The original image was
taken with the 'Kidzlabs' pinhole camera with a
pinhole that was quite large, this resulted in the
collection of ornaments which was subject of the
RPS DIGIT Magazine Winter 2009
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picture being out of focus. lo Photoshop, I copied the
image to a new layer and then flipped it horizontally. I
adjusted the opacity of the layer to 50%, a llowing both the
flipped and origina l images lo be visible. l then completed
the manipulation w ith slight colour and contrast
adjustments. What I like about this image is that the dark
unexposed strip on the left of the original photograph
becomes part of the picture, framing the central section.
These are just a couple of examples of what is possible
when using pinhole photographs as 'raw images' fo r
digital creations. I have found building my own cameras
and producing original pinho le photographs a very
rewarding experience. There is still time to make your
own camera for this year's Worldwide Pinhole
Photography Day.

the arl of pinhole photography. They encourage anyone.
anywhere in the world to make a p inhole photograph on the
last Sunday in April, which then can be uploaded to their online
ga llery. It is a great site to find out about pinhole resources and
events.
How to make a pinhole camera out of a match box
http:/www.matchboxpinhole.com
There are many websites that provide instructions on how to
make different pinhole cameras. One of the best is the
matchboxpinhole.com, this s ite give ve,y clear instmctions on
how to make a matchbox pinhole. Their design also
incorporates a ·cJicker', which is a clever method for knowing
how far to wind the fi lm on between each photograph.

O nline Pinhole Photography Resources
C K Pinhole Photography
http ://www.chriskeeney.com/p h otograph y/
pinhole/ index.html

This website is a great resource for pinhole photographers.
It has a fantastic collection of li nks to other pioJ1ole
photography sites. The site a lso features a d ifferent
pinhole photographer every month, showing the breadth
of how the technique can be used.
Worldwide Pinhole Photography day (WPPD)
http://www.pinholeday.org
This is the website of the Worldwide Pinhole Photography
Day, an international event which promotes and celebrates

Original pinhole f or the Rorschach p inhole image; Ki,/z/abs pinhole
camera; 2 minwe exposure

Rorschach pinhole; Kidz/abs pinhole camera; 2 minute exposure; digita/(1• manipulmed in Photoshop, image has been reversed and layered
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A PHOTOGRAPHER OF
NO FIXED ABODE
Ian Wilson regards himself as something of a photographic Nomad. In his article, he
explains why and discusses some of his images.
s part of a recent publicity drive for Cambridge
Camera C lub, one of my pictures (Closing Time, of
which more later) was among those chosen for
publicarion in ..The Cambridgeshire Journal" to illustrate what
the club gets up to. All well and good, you might think, but
this also involved participating in a questionnaire related to the
image. l had little problem with the more basic questions
(Name? Age? Address? etc.) but one really got me thinking:
Do you specialise in any particular subject matter? Difficu lt.
Very difficult, in fact. After due consideration the answer I
gave was: o, not really. although 1 specialise in avoiding
certain types if possible!
This lack of specia lisation was driven home to me a couple of
weeks later when I took part in an exhibition of local artists in
Grantchester (and, before anyone asks, the church clock told
the right time and there was no sign of any honey for tea or any
other purpose). One of the visitors summed it up rather
eloquently when she saw my work, describing it as ·'an eclectic
mix''. 1 assumed this was just a polite way of saying "random
and lacking in style", but she insisted that lots of variety was
infinitely preferable to an exhibition where everything looked
the same. At least one satisfied customer, then.

A
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Unlike Paula Davies (DIGIT, No 43, pp 8-12). I wouldn 't
claim to be a "Butterfly Photographer flitting from Subject to
Subject" (more a kind of toad hopping about in the leaf litter)
but am very definitely a "Photographer of No Fixed Abode".
I'm happy to tackle most things; but, as the questionnaire
reminded me. there are areas I tend to avoid like the plague.
The most obvious example is fonnal portraiture, which has
a lways struck me as requiring both photographic and social
skil ls in equal measure (and, being an engineer. the latter is
significant ly more challenging than the former). While on the
subject of"things to be avoided", I once agreed to help a work
colleague by photographing his wedding. ever again! In
addition to the skills of the portrait photographer, it's
necessary to add nerves of steel and advanced crowd control to
one·s am1oury: the phrase "herd ing cats" was coined for just
such occasions. But I digress.
Like pretty well everyone reading this article. photography is
a passion and bas been for many years. ft a ll started in the dim
and distant days of the late 1970s when I came to Cambridge
from Yorkshire as an undergraduate and discovered that the
college had a darkroom which I could use. Having bought
myself a Praktica MTL3 (remember those?) and several rolls
RPS DJGIT Magazine Winter 2009

lnis Oirr

of FP4. I began a long-standing love affair with confined spaces. red
lights and smelly chemica ls. After graduating, l bought an enlarger of
my own and persuaded my wife to let me convert the spare room of our
first house into a makeshift darkroom. This worked well for several
years, bul my empire became somewhat diminished when our first
daughter was bom in 1989 since we needed to accommodate a cot and
all the other paraphernalia associated with babies! Talking of houses
and families, I am struck by the fact that following a photographic
passion shares much with the three pillars of the criminal law - in my
case at least - as it is fundamenta lly driven by Means. Motive and
Opportunity. Let me explain ...
Means. This, I suppose. would be better stated as "lack of means".
Financial priority. for obvious reasons. needs to be given to the family's
wellbeing; hobbies - even passions - must inevitably take a back seal as
a result. In an attempt to alleviate this situation l have recently started
selling prints and greetings cards: an interesting and slighily scary
venture, but one which is helping to fill my 5D mkll piggy bank.
Motive. l discovered 1hal children are a double-edged sword when it
cornes to photography. They make superb subjects (at least, they do
until they become self-conscious); but are also highly demanding in
terms of time and energy. My darkroom became a haven of peace
within the family maelstrom, with time spent in it having wonderful
restorative powers (and, no, I wasn't hitting the fixer bottle!). Even
after its transformation into a computer room, I' m relieved to report
that the magic still works.
Opportunity. As with "means" above, having a job and young
children results in very few opportunities for photography, in te1ms of
both time and location. Weekends come and go, usually consumed by
the chores and minutiae of everyday life. This leaves the local area,
fami ly holidays and the odd outing as pretty well the only opportunities
to take pictures. I am convinced that, ultimately, this was the cause of
RPS DIGIT Magazine Winter 2009
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my nomadic photographic behaviour. and exp lains why the
subject matter is so diverse in terms of style and location. Like
thousands of other amateur photographers out there. it was
simply a matter of Hobson's Choice. You have anything
between half an hour and two weeks in (insert the name of a
location here) to take photographs. sta11ing from ... NOW!
Enough waffie already. Let's look at some pictures!
Clare Bridge in the Mist

The first image. appropriately enough. is in monochrome and
was shot on film. ll is also of Cambridge. which has been my
home since arriving as an undergraduate in I977. The fact that
I've never quite got round to leaving says something about the
place, with its peaceful atmosphere and fabulous mediaeval
buildings. Very occasionally. during the Winter, the mist hangs
o,·er the river all day, despite the best attempts of the sun to burn
it off. This particular image of Clare Bridge was taken in
December 1999 around mid-day. and was one of a series I took
in the wonderfully foggy cond itions. Having tried (and failed)
on previous occasions to represent the '·feel'" of fog in a
photograph, I was experimenting with a new film which had just
come on to the market: rlford Delta 3200. As I discovered, the
combination of film grain and low contrast was absolutely
perfect for the conditions. Nowadays. shoot ing digitally, I still
tend to use an ISO setting of 1600 or 3200 to try and recreate the
atmosphere portrayed with this film.
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I'm one of those people who seem to be perpetua lly behind the
times. as my family never tires of reminding me. Photography
is no exception. and having adopted the Canon FD system in
1980 I conrinued to use it for 25 years. Why? Wel l. I refer the
honourable gentleman/lady to the answer I gave earl ier! Means
were limited. and using an obsolete system allowed me to buy
some superb equipment relatively cheaply as a result of others
catching the "upgrade bug··. Later. as more and more people
followed the digital route. l stuck resolutely to film: partly
because I liked being old-fashioned: but mainly because I use
computers every day for my work. and wasn't too enamoured
of sitting in from of a screen at home as well.
By early 2005 the time had come - eventua lly - to embrace
change and go digital: I sold my collection of FD kit. replacing
it with a Canon 200 and a couple of L-series zooms. This came
as a triple shock to the system. as I discovered auto-focus and
colour photography at the same time as having to learn about
digital image processing. Although r d spent a couple of years
printing colour negatives in the darkroom (someth ing I gave up
when those working digitally could produce berter results and
see what they were doing) I had always leaned towards
working in monochrome. Suddenly I found myself a world full
of colour. and was li ke a kid in a sweet shop as a result. lt was
a family holiday to Crete wh ich was the rea l turning point. and.
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like all true aficionados, I spent significantly more time
photographtng the hotel's pool than I did swimming in it.
Although it was never intended at the time. several people
have commented that I must have been paying homage to
David Hockney. Well . like me. he is a Bradford lad after all ...

combination of weather and subject matter (plus an element of
"colour overdose'' from al l those cottages) allowed me lo
experiment with d igital monochrome for the fi rst time.
Unsurprisingly. l was hooked all over again.

lnis Oirr

l have a dog (a slightly scatty labrador called Amber) and earlier
this year decided to have an outing to Crufts 10 see it first hand.
Saturday happened to be ··Gun Dog" day, and I spent many
happy hours wandering ar0tmd the show chatting to people who
were even more infatuated with their animals that I was with
mine. The overwhelming majority of owners were more than
happy to be photographed: the same could not always be said of
the hounds themselves, unfortunately.
I decided to see if I could capture some of the flowing motion
of the dogs with their hand lers in the judging ring, bu t found
that it was almost impossible to get a good viewpoint from
which 10 take pictures. Away Crom tbe main rings there are lots
of practice areas. and these proved to be much more
appropriate. As well as having far fewer people around, dogs
and owners would go backwards and forwards along the same
piece of matting, allowing several opportunities to try and get a
good shot. Even so the hit rate is embarrassingly low, and the
si tuation is made worse by the very strange mixtme of light
sources at the NEC. The chosen image attempts to capture U1c
special rapport which exists between dog and handler, and has

In 2007 the family went on holiday to the Republic of lrela1Jd.
staying for a week at the southern end of Galway Bay before
moving to County Kilkenny for another week. The novelty of
colour hadn't worn off yet, and l was bowled over by the
traditional painted cottages to be fotrnd in many of the local
villages. I started snapping away: and, over a period of time,
a U1eme of"graphic shapes. bold colours and strong shadows"
began to emerge. This evolved into my ARPS panel the
fo llowing year; but that's another story. of course.
Wh ile on the West coast, we took the opportunity for a day trip
to lnis Oirr, the innermost of the Aran islands. As is often the
case in Ireland, the weather was wet, misty and grey on the
chosen day, mean ing that a certain amount of imagination was
needed when attempting to observe the "magnificent Cli ffs of
Moher"! Once on Inis Oirr. however. the weather cleared
enough for us to go fo r a trip around the island by horse and
trap (the lanes being too narrow for motor vehicles). The
landscape is very sparsely populated. and is covered in
hundreds of tiny fields StuTOunded by dry stone walls. The
RPS DIGIT Magazine Winter 2009
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what can only be described as '·a pleasing lack of
defin ition".
Early Morning, Cromer .Beach
Speaking of dogs, I could cheerfully strangle mine
sometimes. My wife and I had gone for a weekend away in
Cromer (no. not that kind of weekend - she was attending a
dol l-makjng workshop in Sheringham. a few miles along
the coast). We took tbe dog with us. and were staying i_o one
of those wonderful old-fashioned guest houses on the cliff
which I thought had become extinct in the I970s. T'm not
sure if it was because of the dog, but we·d been put in a
room right at the top of the hotel: great for the sea view, but
not ideal when Amber decided she needed to go outside at
5:30 the following morning. Uncharacteristically 1 had the
presence of mind to pick up a camera at the same time as the
dog lead, and ['m very grateful I did. The beach was
deserted apart from me and my four-legged friend, and on
this occasion we were treated to a fabulous sunrise over the
pier.
Thinking back to my comments on '·opportunity", there
have been many occasions when I have only been in the
right place at the right time to take a picture because of the
dog. On a few of them. I've even had a camera with me ...
Two-way Traffi c

Think of'Tuscany" and what spri_ngs to mind? Tony Blair?
Chianti and Olive Oi l? Dawn pictures of villas and cypress
trees in the mist taken using Charlie Waite's tripod holes,
perhaps? Another family hol iday resulted in us passing a
very hot and mosquito-bitten week between Pisa and Siena
in August 2008. I didn' t see any point in trying to take the
same pictures as everyone else. Besides, the lack of a car
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and the presence of a two teenage girls meant that pre-dawn
starts were unlikely to be on the agenda. In the evenings we used
to visit the old town. perched high on a hill above the place
where we were staying. As the sun went down. the local
inhabitants - mostly in their seventies and above - would venture
outside into the cooler air. I spent a litt le while observing an old
lady who was attempting to impose her will on a smal l dog
which obviously had a mind of its own. The battle came to a
head in the main square. and I managed to grab a shot of the two
of them standing next to the arrows pointing in opposite
directions. Photography is meant to be fun, and T love any kind
of qu irky shot which can portTay the humour and - let's face it absurdity of eve1yday life.
Beans fo r Drying
Another weekend away. only this time without the dog who had
been banished into kennels. There was a good reason, though,
as we were in Cornwall specifically to visit the Eden Project and
Lost Gardens of Hel igan. Impressive though the Eden Project
was. I confess that l enjoyed Heligan far more. It's one of those
places which is large enough to swallow the crowds which
descend on it. and there's something for eve1yone there: I was
rather taken with the walled garden, greenhouses and potting
shed - especially the potting shed! I'm not one of life's
gardeners, but there was someth ing very comforting about the
place with its ordered stacks of terracotta. Maybe, being murky
and damp, it reminded me of being in the darkroom? There
again, maybe it's just the "shed" mentality which seem. to be
burned so deeply into the male psyche?
A couple of weeks before the trip I'd treated myself to a
Panasonic LX3, which possesses a rather fine wide-angle Leica
lens. Th is shot was taken on the compact camera, as there
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simply wasn't room to swing either an SLR or a
cal. I needn't have worried about quality,
however, as the LX3 is a superb perfonncr, being
easily capable of producing A3 prints. Just as
well, as this one turned out to be my most popular
image by far at the Grantchester exhibition. and
I've now sold half a dozen framed prints and lots
of greetings cards of th is particular picture. l"m
sti ll not quite sure exactly why this image has so
much appeal (not that rm complaining, of course)
but it's fi nally made me realise that my
photography could become partially self-funding.
Exciting stuff. ..
Closing Time

Rather appropriately, the final image in my Desert
Island set is called ·'Closing Time". Much to my
surprise it was selected for this year's London
Salon. and r d like to say that it was a wellplanned and perfectly constructed masterpiece.
I'd like 10 but I can't, since the fina l image was
pure serendipity!
As part of a workshop I ran for Cambridge
Camera Club on flash techniques, a group of
individuals congregated close to King's College
and spent a very happy evening, as it got dark,
flashing at anything which moved. The shop in
question closed at 7:30, and I spotted the chap
about to lake the sign in fo r the night. Since the
camera was mounted on a tripod. I thought it
might be fun 10 t1y and capture his movement
agai11St the static shop front. The first shot was of
him picking up the sign. but then a random passerby walked into the scene. I had on ly one
opportunity to capture the two individuals,
walking in opposite directions. as the exposure
was about half a second. What you see is the
result: a combination of the initial vision and a
healthy dose of luck.
Postscript

So, wi ll this nomadic photographer ever set!le
down? The simple answer is: I hope 1101! Ifs
great fun being a '·Jack of all trades" even if inevitably - one ends up as "master of none".
Although not represented here, l have recently
rediscovered the joy of natural history
photography - somethfog I baven 't tackled in
many years. Who knows, one day I might even
pluck up enough courage to attempt some
portraiture again? But weddings? ever! We are
fortunate, as photographers, that our passion is so
universally applicable. Why bother to wear the
strait-jacket of specialisation?

Benns for drying

Other in formation
Website:

http://photography.greenmen.org.uk
Blog

http://littlegreenmenphotography.blogspot.com
Ca mbridge Camera Club

http://www.cambcc.org.uk
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THE COOKE CHALLENGE
This time we have four more images from DIG members who explain how they created
them. I hope you'll find these interesting and helpful techniques to use in your own
photography. If you do, why not join in and send me some of yours? Email me at:
digitchaUenge@gmail.com

Sharon: as taken

Sharon: finished image

Sharon by Robert K Croft LRPS
I . Load image into Photoshop CS4.
2. Select background, using the Quick Selection Tool
3. With the background now selected, go to drop down menu
Image, click on Adjustments, click on Selective Colour,
change the colour square to white, with the Preset on Default
and the Method checked on Relative, move the black slider
to the left to make the background white then deselect.
4. Go to the drop down menu Filters. Click on Stylize then
click on Find Edges and apply.
5. Go to the drop down menu Image, click on Adjustments,
then click on Brightness / Contrast, leaving the Use Legacy
Box un-checked. Move the Contrast slider to I 00% and click
OK.
6. Go back to the drop down menu Image then click on
Adjustments, click on Hue / Saturation taking the Hue slider
to minus 180 and the Saturation slider to minus 50 and
leaving the Lightness Slider on zero.
7. Crop the image to the required size.
8. I then put on a double border. Go up to the drop down
menu Select, click on Select All. Go back up to the drop

down menu Select, click on Modify, and click on
Borders. I gave my border selection 6 pixels. Click
OK.
9. Go to drop down menu Edit, click on Fill. r chose
to fill with the Opacity set to 75% black and with the
Blending Mode set to normal, click OK.
10. Go back to the drop down menu Select and deselect.
11. Go to the drop down menu Image, click on
Canvas Size. I chose to enter 0.5 inches Width and
0.5 inches Height, making sure the Relative Box was
checked and the canvas extension colour was set on
white. Click OK.
12. Go back up to the drop down menu Select, Select
All. Go back up to the drop down menu Select, click
on Modify, then click on Borders. I gave my border
selection 6 pixels. Click OK.
13. Finally, go to drop down Edit, click on Fil1. I
chose to fill with the Opacity set to 100% (50%
Grey) setting and with the Blending Mode set to
normal. Click OK.
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The.finished image

Image 2
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Panorama Whiston C hurch, Northamptonshire by
Max G reen LRPS

I take my pictures quite often when taking the dogs for a
walk or perhaps returning from a shopping trip. I rarely
carry a tripod around with me so this is an "easy to
achieve'· method that works for me.
I found the highest point I could and took two portrait
fonnat exposures (rmage I and Image 2) making sure that
my exposure did not change between the two and that they
overlaped by a third.
Both pictures were taken in RAW and not adjusted. lfyou
n·y to adjust before merging its easy to get one darker or
more saturated than the other.
The process in CS4 is simple and automated.
Select FILE > AUTOMATE >PHOTOMERGE select
chosen image fi les.
Select AUTO and BLEND. Click OK and Photosbop gets
to work align ing and joining the images.
As you see on the screen grab two separate file layers are
shown.
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Lens correction

Flatten and crop the layers.
I then made a duplicate layer and used the Lens
Correction filter ( FILTERS > DISTORT > LE S
CORRECTION) to adjust any abnormalities.
You can get really good qua lity images this way as you
are nearly doubling your camera's pixel count.
Hopefu lly by being able to keep the camera fairly level
due to the portrait fonnat you do not need to adjust for
perspective. The rest is just ordinary image adjush11ents
as any other photograph.
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The fi11ul image

1mage Refl ection by Gitta Lim LRPS
This isn't exactly a realistic reflection effect but
rather a mirrored reflection of your image. Jr
works quite well on web pages and slideshow
presentations. It looks particularly good when
placed on a webpagc that has a black background
and alternatively on white using a white gradient.
Open your image file and make a Layer 0 out of
the Background in the Layers Palette by doubleclicking the layer to create a transparent
background. Then enlarge the canvas size height
downwards in lmage>Canvas Size by 100%. See
Screengrab I . ext create a copy layer out of
Layer 0 using Crrl+J keys and name it 'Reflection'.
You now need to flip the Reflection layer by first
hitting Ctrl+T keys to create a Transform
bound ing box around the image. Drag the top
(centTe) side hand le past the bottom handle to flip
the image. Drag until you are happy with your
reflection size. No need to use the full canvas if it
looks fine at a smaller size. To resize the canvas go
to Edit>Trim and pick the Transparent Pixels
option. If you wish to create an exact mirror flip of
the original then drag the centre Transform
reference point on top of the the bottom side
handle and go lo Edit>Transfonn>Flip Vertical.
The reflection layer now needs an added
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Screengrab 2

graduated effect. I used a black gradient effect here. You need to hit the D key
to ensure the background colour is black. Pick the Gradient Tool from the
Tools palette. Next go to the Gradient Picker dropdown menu at the top left
corner in the top toolbar and pick the black to transparent gradient. Sec
Screengrab 2.
On the Layers Palette click the eye icon of your Layer Oto deactivate it. You
will now add the gradient on your reflection layer. Place the Gradient Tool
crosshair at the bottom edge of the layer and while holding down the Shift
key drag upwards to the layer top edge.The bottom part of the reflection
shou ld now look totally black.Depending on your image type you can use the
up/down arrow keys (hit first Lhe V key) to nudge the activated layer slightly
up or down to lose some of the centre area between two layers. You can also
add filter effects on the reflection layer using Filter>Blur>Gaussian Blur. 1
also
added
Fi lter> Distort> Ripple
effect
and
used
Edit>Transfonn>Perspective to change the reflection angle.
Then flatten your image and add your watermark to finish it off.
R.PS DIG IT Magazine Winter 2009
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Freedom Fighters by Jim Bucldey LRPS
My original picture was shot on
Kodak negative stock and owes a
good deal to Don McCu llin who was
working with me. I love dropping
names! Well, it wasn't quite like that
but in 1980 as private secretary to the
Governor of Southern Rhodesia
photo opporrunjties were abundant,
if sometimes a little tense. Some
20,000 fully armed freedom fighters
had assembled in this particular
camp u.nder a deal to allow elections
to proceed reasonably peacefully and Final image
with not too much intimidation.
On this visit a touchy press photographer
suspiciously demanded to l<11ow which
paper I worked for. Mr McCull in
was relieved when Texplained who T
was and that I wasn't about to steal
his scoop.
When he saw my 135mm lens on my
Spotmatic be laughed: Put a wide
angle on! Get c lose in! Come on, I'll
Detail
Blur applied
Erased pans
show you. And so followed an
starting out with DI.
magazine - together with the frame line
intense session in photo journalism
Because I wanted to emphasis the three
where it intersected those parts that I
in which I timidly followed his lead
central fighters, I cropped from the left
wanted to be shown. In the centre
as he got right in amongst the AK47s
and then drew a frame with the
thumbnail I've switched off the bottom
and rocket grenades. I fancy his
Rectangular Marquee Tool (M on the
layer so you can see where l've rubbed
pictures were stronger than mme!
keyboard)
around them on the second
out those parts that extend beyond the
Still, I was pleased with this shot at
(copy) layer. I used about 5 pixels of
frame. As you work on detrul you can
the time.
feather for a slightly soft edge. Next, I
vary the size of the Eraser Tool using [
25 years later digital imaging offered
chose Select>Inverse so I had that part of
(left square bracket fo r smaller) and ]
me the chance to give it rather more
the picture outside the frame selected.
(right square bracket for larger) on the
impact, creating a more threatening
To
create a zoom effect, I blu1Ted the
keyboard.
impression with their weapons
outer part using Filter>Blur>Radial Blur
The erased elements now appear in front
coming out of the frame.
and Zoom. This filter does not have a
of the frame and on top of the blurred
This was my route to the image
preview
so you have to experiment a little
background as shown in the detail on the
above which I first made in 2004 and
to get the precise degree of blurring that
right. If you make a mistake, press
have since remade for this
you want, as shown in the left hand
Edit>Step Backward; and keep saving
ChaUenge.
thumbnrul above.
frequently so you don't have to go too far
Having improved the scanned
But of course this also blurred those parts
back. It's also helpful to reduce the
negative a little with Levels and
of
the guns, boots and magazines which
opacity of the copy layer on which you
Unsharp Mask, I duplicated the
were outside the frame. Before bringing
are working to enable you to see just
background layer in Photoshop. Trus
these
elements back in l delineated the
where you need to erase.
allowed me to bring back elements
frame using a light, neutral colour by
If your software bas the facility, you may
of the original picture when I
inverting the selection again and choosing
prefer to use Layer Masks which will
wanted. 1 hadn't learned about
Edit>Stroke
at about 2 pixels.
make corrections much easier and allow
Masks and it was all long before
Selecting the Eraser Tool (E on the
you to go back and modify what you 've
sophisticated non-destructive tools
keyboard) with a small brush, T removed
done at any point.
so this simple two layer technique
carefully the rifle tips, boots and
may be of interest to those who are
RPS DIGIT Magazine Winter 2009
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MY PRESENT
A Seasonal Musing
On the fi rst day of Christmas my true love gave to
me. Enough of that - listen to this .. .
1 was given a Sinclair-Rover ZX 12 Special Tourer
Compact DSLR. OK, I got it early as my birthday
is just before Christmas - but in time to get you the
news that wil l make you want to dash out and get
one too.

Great Tidings ofGood News

Right: Moving Hig her

Below: Holding breath
i11 a11ticipatio11
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without the need for separate bullons - now that is
good thinking. Fewer buttons means less
confusion, after al l my mobi le phone would be far
better with just two buttons: ·an wer' and 'don' t
answer' rather than the ten million that it docs
have. Why don't designers ever think like this?
So this 'fam ily friendly· feature allows you 10
change the appearance of the camera at the touch
of the FF button o that whatever your age or
gender (or preferred hair type) you can look
'cool'. H brings the fami ly together so that you all
feel good together - brilliant! No more isolated
photographic holidays - you all can get out there
together. The government could do with thinking
like this in their many committees!
J chose 'hot icicle· for my test colour! And it did
seem to help me to take better images too. Just
shows that if you are comfo11able with your
camera then better images will result.

Compact'? You could have cooked the turkey in it.
Big enough to caprure any scene! The size of that
LCD too! At lea. t 22 inches but oh so thin and flat
- cleverly it can be rolled up and tucked away into
one of the 'apartments' in the side. How good is
that?
I wi ll go through the main feat11res. I can hear you
all j umping with exci tement - or the effects of
champagne?
The Ultrn Automatic (eye sensing) Zoom can tell
what you' re looking at and sets the Zoom for you.
The planet Saturn in the viewfinder just blew me
away. Macro easy. Just look at a bug and bingo, a
twenty-two inch beauty in 256 colours. (A
fi nmvare upgrade promi sed for 2012 will give
even more colours.)
The Sinclair-Rover engineers are obviously
photographers who know how important a real
viewfinder is. They know that the more pieces of
glass in the way the worse the light-path and the
view. So they removed it all to create a 'straight
through view'. Clever: effective; clear: bri lliant.
I particularly like the rotating barrel lens set: no
longer any fiddly lens swaps. No more dust
bunnies (a lthough I do li ke rabbits - shame). There
are eight fixed focal- length lenses and two coatedzoom-lenses (for winter shots I presume - as it can The brochure says that the camera is best suited to
get pretty cold out there). More on this unique lens nature photography. Mmm: not my scene. Oh
hang on - no it's ·nurt11re· photography. What on
set up later.
Anyvvay let's get down to the important basics. I earth is that? Now this blew my mind. It seems
am sure you arc really keen to bear my iJ1-depth that the camera has specia l temperature and
moisnll'e sensors and can work out from these and
assessment.
The 'family frie ndly' featu re is in a class of its from what's in the viewfinder what you arc trying
own and by itself justifies the £2,562.56 price tag to do. So it automatically adjusts everything for
(excluding VAT). It comes in 256 FF colours. Yes you. It ·nurtures· your photographic experience.
256. There's a special button that you press and But it has a trick up its sleeve. Just in case it senses
turn to access the full range of colour options that you don ·t really know what you want (and
RPS DIGIT
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how many ofus are like that) or perhaps you're in
two (or more) minds, it sets 256 different settings
and snaps at each one - all in under IO seconds. As
the brochure says: · ... guaranteed to get at least
one good shot in every shot' . Now that 's
marvellous - guaranteed results every time. I could
give them anolher £ 1.000 just for that.
Does it use memory cards? Nope. none needed
ever. Think of the saving! It has a 5 terabytc
internal hard drive memory. Never will you be in
the situation where you have carefully set up your
camera, waited for just the right moment, only to
discover that you forgot to bring any memo1y
cards.
There is no need for wires lo connect the camera
to your computer either as it uses a Maglev
induction loop transfer system (MfLTS) to
transfer images directly to your PC! They claim
it's faster but I just like the fact that I have fewer
wires hanging about and also the way the camera
hovers just above the computer case.

That swivel LCD is just great but underneath,
hidden away. are a ton of burtons for those who
need them (not me). They cover just about
everything and anything and there are even some
that appear lo do nothing at all; they' re just there
for you to impress your fr iends. It must work too
because the gasps are almost audible when I show
my latest piece around.
This is a camera for serious photographers. For
those of us who have to get that shot there are no
excuses: this is where the unique lens setup comes
into its own. Click the ·get that shot no matter
what' button and it automatically grabs all of the
possible images that it can with each lens in turn it fair ly whizzes around! Ah, I hear you say that"s silly because it would cause camera shake.
Not so: those engineers at Sinclair Rover arc way
ahead of you. They worked out Lhat if it rotates at
just the right speed then it will act as a gyroscope
and it will stabil ise the whole camera to stop all
vibrations, camera shake, wind effects - you name
it. Bri lliant: all this high end technology in one
package.
This mode uses up half the memory as it takes so
many shots - but its worth it to make sure that
you've got that ultimate shot in there. Must-have
shots, sorted!
But of course all of tltis is nonsense if the image
quality (!Q) is poor. Do we need to know the exact
RPS DIGrT Magazine Winter 2009

number of pixels to know that the IQ is the best Young
there is? How many of us have bought cameras of G"'ynn
x or y Mega Pixels only to find that their lQs were
poor at best. So those clever chaps al Sinclair
Rover refuse to tell us the number of pixels - no
disappointments. AND on top of that they say the
number of 'actua I pixels ' .--......-- - - - - - - - - - ------:::-.,.....,:------,
varies from shot to shot
as it adjusts to get the
best image possible:
something to do wi th
removing noisy and
irrelevant parts.
And that brings us nicely
on to - noise. Noise rs
the bug bear of all digital
users but not for the
ZX I 2. It has bui lt in (no
less) an algorithm that ...__ ___...______________...;:::w
'compares all images and elim inates all noise'. I A lot of Ps
think they refer to it as a 'd ifference engine' in the
brochure. It is the camera we have all been waiting
for. No noise! This explains why there is no fSO
setting button. r kind of missed that one for a
while. I fe lt uneasy always shooting at ISO 64.000
but the proof is in the pudding as they say.
In fac t it is so good that I never moved it out of
auto mode - well to be honest l couldn't actually
find the right button to do anything else. but it's left: What'! You m ean to
say it 's yet an other
there somewhere.
A3 prints? Well. of course Sinclair Rover say that feature?
the A3 's performance is second to none but as l
am still downloading my first pictures. l catlllot
refute their words. Everything else they have said
is there is there so I don ·1 expect any surprises.
There is just one minor problem, which the boffins
at Sinclair Rover say they are working on and will
have a fix for in the ve1y near future: the battery is
a bit on the large. heavy side and it doesn't really
last that long - but then this is a pioneering, first
generation camera, so it is to be expected.
l" m off to see my Osteopath next week. I seem to
have developed a bit of a nasty pain in my back. l
probably should have bought the soft, contoured,
'rest me' bag for Lhe camera right at the start. But
come on - camera bags? They're for wimps!

I think I 'II stick to 111hat I
know thanks!
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Sh arpen in g with High Pass Filter

The sharpening filter you probably didn't know you had
In this third article, following the starter piece in the spring issue of DIGIT this year (No 4 1)
and the 1nore sophisticated sharpening techniques like luminosity blend mode and selective
sharpening covered in No 43 in the autumn, Clive now presents an alternative method of
sharpening an image and one that presents an amount of flexibility. It also has the advantage
that it's quick and easy to do. Clive's website at www.crhfoto.co.uk contains a wealth of
information on Photoshop routines, including sharpening.
To prevent colour fringing Desaturate (using
lmage > Adjust> Desaturate) the High Pass effect
- as shown below.

Now we need to blend the two
layers togther.
,No,m,I
( v
Set Layer Blend Mode to
Norm,!
Dusolvt
Overlay. Soft L ight or Hard
Light - choose whichever suits
D>rktn
Multiply
the image. The opacity setting
Cclor&,n
for the layer will also
Llneir Sum
04!ktr Color
influence the sharpening
effect.
L~tn
Scrt-tn
A further refinement is the
Cclor Dodge
application of a Layer Mask.
Lino.,Dod9t(Add)
Llghier Colo..
This enables parts of the
sharpening layer to be
Softt.JQht
selectively erased (using black
Hard Light
as the foreground colour) or
Vlvldt.JQht
lnu, Light
restored (using wh.ite as the
PlnLIQhl
H•rd Mix
foreground colour) with a
suitable size of brush.
The following screen-grab details illustrate the
effect of Hi-Pass Sharpening at a screen
magnification of 500%
LAYERS I

Above: The starting
image: a studio portrait

of The Fishemt(III
Below: Backgro1111tl

Copy l"yer

.....,.,

1.AYOt< - - - - ~ . . . - . .
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•
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Below: High Pass filter
locatio11
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his method addresses principally the edges
of subject matter and areas of contrast
change. This makes it an effective method
in avoiding sharpening areas of the image which
may contain noise or those which are soft and
diffuse.
Open the picture as a Background Layer.
Make a copy of this layer, placing it on the layer
above, as shown left.
With this layer active, go to: Fi lter > Other > High
Pass. The location of this fi lter is shown below
left.
Set the High Pass radius to between 4 and 8 - this
increases the fringe effect, as shown in the picture
below.

T

..
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Next in the Clive's technique series
will be Sharpening Edges Precisely.
Look out for it in the spring DIGIT.

A DIGITAL IMAGING WEEKEND WORKSHOP
2~ and 25 APRIL 2010

This weekend workshop, where there are just 36 places, will be led by Graham Whistler
FRPS (studio portraits), Cl ive Haynes FRPS (RAW files and Photoshop) and Simon
Walden (principal photographer at Cheltenham Film Studios - fashion and nude
photography), who is well known for his workshops at the studios. Two professional
models will be booked for the weekend. There wi ll be instruction on the use of botb
Canon and Nikon DSLR cameras. Pem1aJet arc supporting lhe event with printers and
paper and you will be able to piint your pictures. All three tutors will display examples of
their work. There will also be room for members Lo display their pictures taken during the
event. Bring your own laptop. Lunches available and a Travel Lodge and hotels are nearby.

To reserve a place contact Graham Whistler at graham@gwpmultimedia.com
or phone 01329 847944.
£50 deposit req uired and ba lance by I Februa1y 2010
RPS DIGIT Magazine Winter 2009
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----TONY HEALY ARPS

WIDESCREEN ALASKA
A panoramic taster for Tony's article, planned for DIGIT next year, on his Alaskan trip.
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- - - - JIM BUCKLEY LRPS

MAC CORNER

Apple Macs have a growing market share. With elegant design and loads of included
software they are ideal for photographers. Here DIGIT seeks to offer something specific
for the small but increasing number of Apple Mac enthusiasts in the DI Group. But we
need your help to make this a regular feature so please send your reviews, favourite tips
and your expertise to: editor@digit.rps.org and help spread the knowledge. I'm very
grateful to Tony Healy ARPS for help with this first page.
Slide shows on the Mac
Apple Macs come with a sometimes bewildering
array of software to do anything from compose
your own music to make and bum video shows.
Arguably you don ' t need to buy any third parry
software with Apple·s word processing.
spreadsheets.
photo
management
and
manipulation all at hand. ln a brand that's aimed
at graphics users and video or movie creators. the
Macs are pa11icularly strong with both iPhoto and
iMovie. When combined with iDVD they offer a
powerful and sophisticated model for creating
exciting and fast moving shows in a variety of
formats ranging from Utube to HD TV. But what
if you want something straightforward to make a
little AV show of your holiday snaps to share
quickly with friends?
H may seem surprising but you may want to look
outside Apple at a cheap. stand alone program to
make slide shows with a mixture of still
photographs and video clips in the story. coupled
with a sound track. narration, a range of fades and
dissolves, pans and zooms and titling. Yes, just
like the Society Harmony distinction slide shows
Take a look at German company Boinx 's
Fotomagico for US$29 (www.boin x.com ) or
possibly free when bundled with DVD software
burning offers. This program, designed for the
Mac, allows you to take your phot0s and movies
in pretty much any format from a memory card or
... ·~~~ ·
drive and create a l:::::=::=::=:=::::::=::::::::::;;;;:::::::::=:~==~·!a::
slide show wl1ich can
be burned in a variety
of fo rmats using
iDVD. It's totally
compatible
with
Apple"s software and
whilst in one sense it
offers nothing new
C!I!@•
I iili • I II ~
it's a very conven ient ,-.- iiii--•--,
way to create a quick
show.
On opening the program and selecting the output
format - anything from an HD video to a
QuickTime movie - it's like most AV software:
simply drag your photos and sound tracks into the
@ (!!!E} c.,.,,... >
lower tray and zoom, pan and rotate.
r-,I Fn l'Of
Sadly, this is one example where more is less and
M£Wl'OF
S.,yt a, POf• X
in my view the company's Pro product is overMW: P'Of" ~o 1,no.10
priced at $149 so stick to the simple version. A
W&IWlt·lrh&#hi· Jlt.fatiM
free 5 day trial is available so you can assess it.

.iiil
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Invisible Gamma Confusion
Had you always associated Macs with a gamma
value of 1.8. whilst Windows used 2.2? Think
again. With the new Snow Leopard operating
system on OSX v 10.6.2 now, you've probably
upgraded and noticed nothing. But Apple have
slipped in a change to a gamma value of 2.2.
You shou ldn't need to recalibrate your display and
it all happens behind lhe scenes with the computer
taking your images and videos colour space
infomrntion and converting it. But what if you are
working with images without colour profiles?
They may appear too dark on the screen. The
solution is to use Preview to add a colour profile
so your pictures display correctly. And if you want
to continue using the traditiona l Apple 1.8 ga1mna
et this in System Preferences>Displays and select
this profile in Displays Preferences. There·s more
at: http://support.apple.com/ kb/HT37 12

Mac Help

A usefu l site: http://reviews.cnet.com/ macfixit/
Have you ever been puzzled when starling to type
in a name in Mail address and finding up pops an
emai l addresses that doesn ' t look right'? Perhaps
you knew ii had changed but you couldn't find that
particular address in your Address Book to
remove it. It's probably in Previous Recipients
located within Mail under Window> Previous
Recipients. If you no longer use them simply
Remove from List. Have a look at yours.
Tip for MAC users.
When you download an app lication and
subsequently receive a serial number or activation
code you probably have a way of storing this
infonnation safely just in case you have to reinstall the application. Perhaps you prim the email
or text detai ls or create a ·Keep· folder in Mail and
file it there. But Apple has - - - -v-o-uR- provided a Web Receipts - PL.Aco HOMEFold....
fo lder for this sort of EJ 0t
~ ktop
(h
information. lt's in your h
_,\_ Al)pfluuons
Home
folder.
under B Mov1u
Documents. Open the email /J Music
__.
and click the Print command. ..__
i:illM Pictures
In the dialogue box 1=======-========i
here choose PDF in the
bottom
left
hand - ( B • r-.
- ......
corner. Then select
o- • • •
Save to Web Receipts
o.... ,...
(left) and the job's \
,..
done.

_____

- ..--

_.,_
------

-·

47

3

www.permajet.com
sales@permajet.com

